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¿Observas el sensor en la parte superior de la puerta? La computadora lo 
usa para decir si un humano está frente a la puerta, ¡y el motor girará para 
abrirla o cerrarla! Por supuesto, una computadora no puede decidir esto por 
sí misma: un humano tiene que enseñarle qué hacer primero. ¡El proceso 
de enseñarle a una computadora qué hacer se llama programación!

Aside from automatic doors, you can find all sorts of examples of programming
in the world around you!

What are they? How are they programmed?

Washing Machines
They're programmed to automatically
detect the amount of clothes and wash 
them when you press a button.

Programming is...

So What's Programming?

Computer

Tells the
computer

Follows the
instructions

Gives the instructionsThinks of
instructions

Human

Program
Programming

Programmer

Sensor

Sensor de respaldo

Motor

Dispositivo de 
control 
(Computadora)

Correa

Robots and lots of other electronics work by following instructions given to 
them by a computer.
But first, a human has to teach the computer what instructions to give and
when to give them.

The instructions that a human teaches a computer are called a program, and
making a program is called programming.
The people who make these programs are called programmers!
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Capítulo 1 
Todo sobre las puertas 

automáticas

Si alguna vez has estado en un supermercado o en una tienda de 
conveniencia, probablemente hayas visto una puerta automática. Gracias 
a estas puertas, ¡no tienes que preocuparte por cómo abrir y cerrar una 
puerta común cuando tienes dos brazadas de bolsas de supermercado! 
Probablemente los veas todo el tiempo en otros lugares también, pero 
¿cómo crees que funcionan?



I f  you've ever been to a supermarket or a convenience store, 
you've probably seen an automatic door. Thanks to these
doors, you don' t have to worry about how to open and close
a regular door when you have two armfuls of grocery bags!
You probably see them all the time in other places, too, but
how do you think they work?

Notice the sensor at the top of the door? The computer uses 
it to tell whether a human is in front of the door, and the
motor will spin to open or close it! Of course, a computer 
can' t decide this all by itself : a human has to teach it what to 
do first. The process of teaching a computer what to do is 
called programming!

All About Automatic DoorsAll About Automatic Doors
Chapter 1Chapter 1

Sensor

Backup Sensor

Motor

Control Device
(Computer)

Belt

La programación es ...
Entonces, ¿Qué es la programación?

Los robots y muchos otros productos electrónicos, funcionan siguiendo las 
instrucciones dadas a ellos por una computadora.
Pero primero, un humano tiene que enseñarle a la computadora qué 
instrucciones dar y cuando darlas.

Piensa en 
instrucciones

Le dice a la 
computadora Da las 

instrucciones

Sigue las instrucciones

Computadora

Humano

Las instrucciones que un ser humano enseña a una computadora se 
llaman programas, y hacer un programa se llama programación. ¡Las 
personas que hacen estos programas se llaman programadores!

Programa
Programación

Programador

Además de las puertas automáticas, ¡puedes encontrar todo tipo de 
ejemplos de programación en el mundo que te rodea!

¿Qué son? ¿Cómo están programados?

Lavadoras
Están programadas para detectar 
automáticamente la cantidad de ropa y 
lavarla cuando presionas un botón.



Estos motores pueden ser 
programados para girar en 
cualquier ángulo de 0 a 180 
grados. Intenta girar cada lado de 
tu servomotor lentamente: ¡el que 
esta más difícil de girar es el que 
programarás!

¿Que es un servomotor?

Studuino x 1 Servomotor x 1

Gira 
libremente

¡Progra-
marás 
este!

Getting Ready1

You'll need to use your Battery Box in order to power your Servomotor.

Remember, your Battery Box takes three AA/LR6 batteries!

It's finally time to start programming your Servomotor, but first there are

a few things we'll need to do to get ready!

Plug the Battery Box into your Studuino's POWER connector.2

1

3 You always need to connect the parts you use to your Studuino.

Plug your Servomotor into D9!

Make sure it 's inserted correctly!

Make sure it's inserted correctly!

Make sure the + and     ends are in the right position!

Cable USB x 1
Cable de la 

caja de 
baterías x 1

POWERPOWER

D9

3

Programando Motores

Necesitarás

Caja de baterías x 1

¿Qué es un Studuino?
Studuino es la pequeña computadora que programarás en esta clase. 
¡Puedes usarlo para hacer robots y otras máquinas, a partir de sensores, 
LEDs y motores!

¡Sé gentil con tu Servomotor! No 
lo hagas girar demasiado duro o 
intentes forzarlo a que gire!

ADVERTENSIA



Studuino is the tiny computer you'll be programming in this 

class. You can use it to make robots and other machines out of 

sensors, LEDs, and

motors!

Programming Motors

You'll Need

What's a Studuino?

These motors can be programmed

to rotate to any angle from 0 to

180 degrees. Try turning each side

of your Servomotor slowly: the one

that's harder to turn is the one

you'll be programming!

So What's a Servomotor?

Battery Box x 1Studuino x 1 Servomotor x 1

Spins
freely

You'll
program
this one!

WARNING Be gentle with your Servomotor! Don't 
turn it too hard or try to force it to turn!

1

Necesitará usar tu caja de baterías para alimentar tu Servomotor. Recuerda, 
caja de baterías usa tres baterías AA / LR6.

¡Por fin es hora de comenzar a programar tu Servomotor, pero primero hay 
algunas cosas que debemos hacer para prepararnos!

2 Conecta la caja de baterías en el conector de alimentación de tu Studuino.

1

3 Siempre necesitas conectar las partes que usas, a tu Studuino.

¡Conecta tu Servomotor en D9!

USB Cable x 1 Battery Box
 Cable x 1

POWERPOWER

D9

4

Preparándote

estén en la posición correcta!¡Asegúrate de que las terminales y

¡Asegúrate de que está insertado 
correctamente!

¡Asegúrate de que está insertado 
correctamente!



Starting Up the Software2

Click
Click!

This software lets you program by 

d ragg ing  and  dropp ing  i cons ,  

almost like you're using blocks!

Program

¡Ahora agrega tu Servomotor al lugar que se muestra en tu base!

Click Block Programming Environment in the window 

that opens. On the next screen, click Robots!

Go to your Desktop and double -click the icon.

You should see the screen shown below.

Conectores - D: 
Servomotores

Conectores - A: 
¡Sensores, LEDs, 
timbres, y más!

(¡No necesitarás 
usar esto en este 
libro de texto!)

Click!

Click!

●③

●②

●①

¡Asegúrate de que está mirando hacia la 
dirección correcta!
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¿Qué puedes usar con un Studuino?
Tu Studuino tiene muchos conectores, con lugares para motores de CD, 
sensores, LED, zumbadores y muchas otras partes. Pero ten cuidado, 
cada parte solo se puede usar con ciertos conectores.

Alimentación: 
Caja de 
baterías

USB: Cable USB 



Iniciando el programa2

Click
Click!

¡Este software te permite programar 

arrastrando y soltando iconos, casi 

como si estuvieras usando bloques!

Programa

Now add your Servomotor to the spot shown on your mount!●④

What can you use with a Studuino?
Your Studuino has lots of connectors, and you can use them 
for more than just Servomotors! It has places for sensors,
LEDs, Buzzers, and lots of other parts! But be careful , each 
part can only be used with certain connectors.

Has Click en el Entorno de Programación de Bloques 

que se abre. En la pantal la siguiente, ¡Click en Robots!

Ve a tu escri tor io y has doble-c l ick en el icono.

Debes ver la pantalla que se muestra abajo .

D-connectors:
Servomotors

A-connectors:
Sensors, LEDs,
Buzzers, and more!

USB: USB cables

Power: Battery Box

(you won't need to
 use these in this
 textbook!)

Click!

Click!

●③

●②

●①

Make sure it's facing the correct way!

6



Plug in Your Studuino
(Test Mode)

4

Click the Run menu at the top of your screen and choose Test ON.●②
Click!

Click!

In order for your PC to send instructions to your Studuino, you'll need to 

connect them with a USB cable. If you want to send an instruction like 

"run the Servomotor," for example, you'll need to use Test Mode!

Connect your Studuino to your PC using a USB cable.●①

Make sure it's inserted
correctly!

USB
Cable

To PCTo Studuino

7

Configura tus puertos3

Has click en el menú editar en la parte superior de tu 
pantalla y elige configuración de puerto.

Antes de comenzar a programar, debes informar a tu Studuino qué 
partes están conectadas. Para hacer eso, ¡tienes que configurar tus puertos!

Click!

7

① ¿Ves los recuadros?

Has click en el botón Desmarcar todo en la ventana que aparece. 

¡Ahora marca el recuadro de servomotor D9!

② Has click en
desmarcar todo

③ ¡Marca el recuadro del servomotor D9! ④ ¡ Has click en aceptar!



① See the　  boxes?

●①

Set Your Ports3

Click!

Click!

Before you start programming you have to tell your Studuino which parts

are connected to it. To do that, you have to set your ports!

●② Click the Uncheck All button in the window that appears. 

Now check Servomotor box D9!

② Click Uncheck All!

③ Check Servomotor box    D9! ④  Click OK to close the Port Settings window!

Click!

Click!

Click the Edit menu at the top of your screen and choose Port Settings.

Click!

4

Para que tu PC envíe instrucciones a tu Studuino, necesitarás conectarla 
con un cable USB. Si quieres enviar una instrucción como "ejecutar el 
Servomotor", por ejemplo, ¡tendrás que usar el Modo de Prueba!

Cable USB

A la PCAl Studuino

8

Conecta tu Studuino a tu PC usando un cable USB.

¡Asegúrate de que está 
insertado correctamente!

Conecta tu Studuino (modo de prueba)

Has click en el menú Ejecutar en la parte superior de la 
pantalla y selecciona prueba activada.



Turn on your

Battery Box.

●① Drag and place a 

Servomotor block

as shown in the

picture.

●②

●③

Working with Servomotors5

Drag

This block runs a Servomotor!

Click the ▲ and ▼ of the block you just placed and your 
Servomotor will change angles. You can also type an angle directly 
into the box!

180°

90°

0°
Click!

Click the number and 
use your keyboard to 
type in a new one!

Did it work? Now we're going to take your 
Servomotor and use it to program a block 
catapult!

Once you've typed in your number, click the 
word "Servomotor" on the block to transfer your 
program and see how your Servomotor moves!

The time has finally come for you to program your Servomotor! The blue icon you 

see on the left side of your screen is the block you'll use to send commands to it.

Click! Click!

ON OFF

9

Abrir el Modo de prueba, hará que tu 
PC y tu Studuino comiencen a hablar entre ellos y 
verás el siguiente mensaje. La desaparición del mensaje 
significa que el Modo de prueba se está ejecutando.

Verás este mensaje si tu cable USB no está conectado 
correctamente.
Has click en Aceptar y verifica que tu cable USB esté 
conectado correctamente antes de volver a ejecutar 
el Modo de prueba.

Si no funciona...Si funciona...

Desconectar tu cable USB interrumpirá la conexión con tu PC y verás este 
mensaje.
Has click en Aceptar y verifica que tu cable USB esté conectado 
correctamente antes de volver a ejecutar el Modo de prueba.

¡No desconectes tu cable USB mientras está en modo de prueba!

Una vez que el modo de prueba esté 
abierto, verás la placa del sensor en la 
parte superior derecha de la pantalla.

ADVERTENCIA 



●③

Arrastra y coloca 
un bloque de 
Servomotor como 
se muestra en la 
imagen.

Enciende tu caja 
de baterías.

Opening Test Mode will make your PC and Studuino start to talk

to each other and you'll see the message below. The message

disappearing means that Test Mode is now running.

Once Test Mode is open 
you'll see the Sensor Board at 
the top right of the screen.

If you see this message, click OK and check that 
your USB cable is connected properly before
running Test Mode again.

If it
didn't...

If it
worked...

●②

●③

Trabajando con Servomotores5

Now you're ready to send
a program to your Studuino!

Arrastra

¡Este bloque ejecuta un servomotor!

Has click en los botones ▲ y ▼ del bloque que acabas de colocar y tu 
Servomotor cambiará de ángulo. ¡También puedes escribir un ángulo 
directamente en el recuadro!

180°

90°

0°

¡Haz click en el número 
y usa tu teclado para 
escribir uno nuevo!

¿Funcionó? ¡Ahora tomaremos tu Servomotor y 
lo usaremos para programar una catapulta de 
bloques!

Una vez que hayas ingresado tu número, has 
click en la palabra "Servomotor" en el bloque 
para transferir tu programa y ver cómo se 
mueve tu Servomotor.

¡Finalmente ha llegado el momento de programar tu Servomotor! El ícono azul 
que ves en el lado izquierdo de tu pantalla, es el bloque que usarás para 
enviarle comandos.

Click! Click!

ON OFF

Unplugging your USB cable will interrupt the connection with your PC and you'll 
see this message.
Click OK and check that your USB cable is connected properly before running
Test Mode again.

WARNING

Don' t unplug your USB cable while in Test Mode!

10



Conecta los bloques 
mostrados aquí.

Your Servomotor needs to turn to angle 1) before moving to angle 2).

Place the blocks shown and set them to the angles you chose in     !
Haciendo una catapulta de bloques6

¡Necesitaremos programar tu catapulta haciendo que tu Servomotor gire en 
un ángulo y esperar un poco antes de pasar al siguiente!

Espera 3
 segundos...

¡Y tíralo!

●③

●⑤

●②

Has click en ▲ y ▼ del bloque
cambiar los ángulos. Una vez que haya encontrado los correctos, 
¡escríbelos en la tabla a continuación!

Tira del bloque de 
vuelta ...

1) tirando hacia atrás el bloque 2) Lanzar el bloque

Mi servomotor debe estar a °       °

●④Connect your two blocks to the               block in order.

You'll need to make your catapult wait a bit between angles 1) and 2).

Click                   ,  drag a                    block, and insert it between your 

two Servomotor blocks!

You can connect a block by dragging it to another block and dropping it 

when the white line appears!

         Angle 1)

            Angle 2)

Drag

¡Ahora agrega la parte a tu Servomotor 
para hacer la plataforma de 
lanzamiento!

,,,,,,,,,,,,,,,,,,,

11

para

Mi servomotor debe estar a



●①Connect the blocks 
shown here.

Tu Servomotor necesita girar al ángulo 1) antes de moverse al ángulo 2).
Coloca los bloques que se muestran y colócalos en los ángulos que 
elegiste en 

 Making a Block Catapult6
We'll need to program your catapult by making your Servomotor turn to 

one angle and wait a bit before turning to the next one!

Wait 3
seconds...

And throw it!

●③

●⑤

●②

●②

Click the ▲ and ▼ of the                                                             block to change 

angles. Once you've found the right ones, write them down in the table below!

Pull the block back...

1) Pull ing back the block      2) Throwing the block

My Servomotor should be at        ° My Servomotor should be at        °

Puedes conectar un bloque arrastrándolo a otro bloque y soltándolo cuando 
aparezca la línea blanca.

Arrastra

Now add the part to your Servomotor 
to make the launchpad!

12

Ángulo 1)

Ángulo 2)

Conecta tus dos bloques al bloque en orden.

Tendrás que hacer que tu catapulta espere un poco entre los ángulos 1) y 
2).

Has click en arrastra un bloque e insertalo entre
tus dos bloques de servomotor!



●⑥

Click!

Hagamos que tu catapulta mantenga el bloque por un tiempo cambiando
el número en el bloque                       a 3 segundos.

It's time to save your program!

Click!

Click!

Save a program and you'll be able to open it any time you want! Listen 

closely to your teacher as they tell you how to do it!

Remember: always turn your Battery Box off and put it

away once class is over! Accidentally leaving it on will 

drain your batteries, and you'll need a whole new set for 

your next class!

Type your 

filename here

Type your 

filename here

Choose a 

folder here

Choose a 

folder here

Click!

Click!Click!

Cleanup

Tu programa siempre se ejecutará de arriba hacia abajo.

ON OFF

How to Save Your Program

13

¡Ahora has click en para enviar el programa a tu Studuino y ver cómo trabaja !



●⑥

●⑦

Let's make your catapult hold the block for a while by changing the

number in the                 block to 3 seconds.

Click!

Now click the                      to send the program to your Studuino 

and see how it works!

Recuerda: siempre apaga tu caja de baterías y guárdala 
una vez que termine la clase. Dejarla accidentalmente 
agotará tus baterías, y necesitarás un conjunto 
completamente nuevo para tu próxima clase.

Limpieza

Your program will always run from top to bottom.

ON OFF

14

¡Ahora es momento de guardar tu programa!
¡Guarda un programa y podrás abrirlo en cualquier momento que 
desees! Escucha de cerca a tu maestro cuando te diga cómo hacerlo!



Building the Door1
●① Connect the blocks shown.

Make three of these! Make one of these!

You'll Need

USB Cable x 1Servomotor x 1

Studuino x 1 Battery Box x 1

Basic Cube (White) x 14

Half A (Light Gray) x 2 Half D (Aqua) x 4 Beam x 2

Puedes haber notado que las puertas automáticas se pueden abrir de muchas 
maneras diferentes. En este libro de texto, programarás dos tipos diferentes de 
puertas: Puertas Táctiles y Puertas de Reflector. Empezaremos por observar cómo 
funcionan las Puertas Táctiles antes de programarlas.

Toca el panel y 
estas puertas se 
abrirán.

El sensor en la parte 
superior de la puerta emite 
luz y se abre cuando un 
objeto refleja esa luz.

Puertas Táctiles

While real automatic doors will slide open to let people in whether they're coming

or going, we're going to keep it simple by building one that only opens backwards!

Battery Box Cable x 1

x3 x1

15

Capítulo 2 
Construyendo una puerta 

automática

Puertas de reflector



Chapter 2Chapter 2
Building an Automatic Door

1 Construyendo la puerta

¡Has tres de estos!

Cable USB x 1Servomotor x 1

Studuino x 1

Cubo básico (Blanco) x 14

Mitad A (Gris claro) x 2 Mitad D (Aqua) x 4 Viga x 2

You may have noticed that automatic doors can open in all sorts of different 

ways. In this textbook you'll program two different types of doors: Touch Doors

and Reflector Doors. We'll start by taking a look at how Touch Doors work before

programming them!

Touch the panel

and these doors

will open right up!

The sensor on top

of the door emits light,

and it opens when an

object reflects that light!

Touch Doors Reflector Doors

Mientras que las puertas automáticas reales se abrirán para dejar a la gente 
entrar o salir, vamos a hacerlo simple, construyendo una que solo se abra 
hacia atrás.

Cable de la caja de 
baterías x 1

x3 x1

16

caja de baterías x 1

Conecta los bloques mostrados.

¡Has uno de estos!



●⑤

¡Conecta tus piezas de la parte       como se muestra!

Conecta los bloques mostrados.

Conecta las vigas y los bloques mostrados a la parte        .

Agrega tu servomotor a la base de tu Studuino.

●② ●①

●③

¡Has terminado 
la puerta!

●③

●④

●⑥ ●⑤Add the Battery Box shown to part    .

●⑦ Add the blocks shown to part    .

●8 Add your door from    to part    .

Keep an eye on the studs!

●6

●② ●7

17



●⑤

Connect your four pieces from part ① as shown!

Connect the blocks shown.

Connect beams and the blocks shown to part    .

Add your Servomotor to your Studuino mount.

●② ●①

●③

You've finished
the door!

●③

●④

Agrega la caja de baterías mostrada, a la parte        .

Keep an eye on the studs!

Agrega los bloques mostrados a la parte        .

Agrega tu puerta de      a la parte      .

18



１
Let's figure out exactly what the program for your automatic door needs to do!

Inclina la puerta hacia atrás y agrega la parte     a la parte     como se 
muestra.

●④ ●⑧

What Your Door Needs to Do 

●① Start with the door closed ●② Press the button (that's the panel!)

●③Open the door ●④ Wait 3 seconds and close the door

Your Studuino has four buttons 

labeled A0 to A3. For now we're

going to use button A0 to open 

your automatic door!

This little round button resets 
your Studuino. Press it to start
your program over from the
beginning, but make sure not
to press it accidentally!

A0

A１

A２A２

A3

●⑨

●⑪●⑩

Programming a Touch Door

D9

¡Asegúrate de que está 
insertado correctamente!

Regresa la puerta a su posición 
original.

Ahora lleva el cable del Servomotor 
al frente y conéctalo a D9 en tu 
Studuino.

¡Terminado!

19



１
¡Vamos a descubrir exactamente qué necesita hacer el programa para tu puerta automática!

Tilt the door backwards and add part     to part     as
shown.

●④ ●⑧

Lo que tu puerta necesita hacer

Empezar con la puerta cerrada. Presionar el botón (¡ese es el panel!)

Abrir la puerta. Esperar 3 segundos y cerrar la puerta.

Tu Studuino tiene cuatro 
botones etiquetados de A0 a A3. 
¡Por ahora vamos a usar el botón 
A0 para abrir tu puerta automática!

Este pequeño botón redondo restablece 
tu Studuino. Presiónalo para comenzar 
tu programa desde el principio, ¡pero 
asegúrase de no presionarlo 
accidentalmente!

A0

A１

A２A２

A3

●⑨

●⑪●⑩

Programando una puerta táctil

D9

Make sure it's inserted 
correctly!

Return the door to its
original position.

Now bring the Servomotor cable to
the front and plug it into D9 on 
your Studuino.

●⑫ Finished!

20



●④

Plug in Your Studuino (Test Mode)3

We'll need to use a USB cable to let your computer send instructions to your 

Studuino!

Connect your Studuino to your PC using a USB cable.●①

To StuduinoTo PC

Make sure it's inserted correctly!

Click the Run menu at the top of your screen and choose Test ON.●②

Click!

Click!

Antes de comenzar a programar, debes informarle a tu Studuino qué 
partes están conectadas. Para hacer eso, ¡tienes que configurar tus 
puertos!

Has click en el menú Editar en la parte superior de la pantalla y 
elige Configuración de puerto.

Has click en el botón Desmarcar todo en la ventana que aparece.

Configura tus puertos2

●②

Marca la caja del Servomotor D9 y el botón A0.

Has click en aceptar para cerrar la ventana de configuración del puerto.

Click!

USB
Cable

●①

21

Click!



●④

Conecta tu Studuino (Modo de prueba)3
¡Tendremos que usar un cable USB para que tu computadora 
envíe instrucciones a tu Studuino!

       Conecta tu Studuino a tu PC con un cable USB.

Al Studuino A la PC

¡Asegúrate de que está 
insertado correctamente!

Before you start programming you have to tell your Studuino which parts

are connected to it. To do that, you have to set your ports!

Click the Edit menu at the top of your screen and choose Port Settings.

Click the Uncheck All button in the window that appears.

Set Your Ports2

Click!

Click!

●②

●③ Check Servomotor box D9 and button A0.

Click OK to close the Port Settings window!

Click!

Click!

Cable 
USB

●①

22

Has click en el menú Ejecutar en la parte superior de la 
pantalla y selecciona prueba activada.



Your Servomotor needs to turn to angle 2) before moving to angle 1).

Place the blocks shown and set them to the angles you chose in  ③ !

Arrastra y coloca un bloque de servomotor.

Arrastra

●③

Tendremos que encontrar los ángulos para cuando tu puerta esté cerrada y 
cuando esté abierta. ¡Mira las imágenes de abajo y haz click en los botones 
▲ y ▼ en el bloque, hasta que tu puerta esté en las mismas posiciones!

1) La puerta está cerrada

Mi servomotor debe estar a     °

●④

For 2) (it's open)

For 1) (it's closed)

●⑤Now make the door close after 3 seconds. Insert a 　　　　　 between

your blocks and change the number to 3!

●⑥Now click the 　　　　　　 to send the program to your Studuino and see

how it works!

Drag

Change to 3

Click!

4

●①

Programando tu puerta para cerrar 
después de 3 segundos

¡Comenzaremos programando tu puerta para abrir durante 3 segundos!

¡Enciende tu caja de baterías para darle algo de potencia a tu Servomotor!

ON OFF
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2) La puerta está abierta

Mi servomotor debe estar a     °



●② Drag and place a Servomotor block.

Drag

●③

Tu Servomotor necesita girar al ángulo 2) antes de moverse al ángulo 1).
Coloca los bloques que se muestran y colócalos en los ángulos que 
elegiste en ③ !

We'll need to find the angles for when your door is closed and when it's 

open. Look at the pictures below and click the ▲ and ▼ in the block 

until your door is in the same positions!

2) The door is open1) The door is closed

My Servomotor should be at     ° My Servomotor should be at     °

●④

Para 2) (Está abierta)

Ahora has click en  para enviar el programa a tu Studuino y 
ver cómo funciona!

Drag

Cambia a 3

Click!

4

●①

Programming Your Door to Close
After 3 Seconds
We'll start by programming your door to open for 3 seconds!

Turn your Battery Box on to give your Servomotor some power!

ON OFF
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Para 1) (Está cerrada)

Ahora has que la puerta cierre después de 3 segundos. Inserta un
entre tus bloques y cambia el número a 3!



3) Now type 0 into the right 〇 of 

the              block.

●①

¿Crees que hay una forma de que tu Studuino diga si presionas A0? Echa un 
vistazo a la placa de sensores en la parte superior derecha de la pantalla e 
intenta presionar el botón.

A0 es liberado

¿Observas cómo cambia el número cuando presionas A0? Tu Studuino 
observa este número y lo usa para indicar cuándo estás presionando el 
botón. Los programadores llaman a estos tipos de números, valores.

Ahora vamos a hacer un programa que le dé a tu Studuino las siguientes 
instrucciones:

Liberado si el valor es 1

A0 es presionado

Si el valor del botón A0 es 0

activa el Servomotor para abrir la puerta (esto es lo que programaste en !)

Como dice, si ~ ○○ solo ejecutará la acción es ○○ si la condición es ~ es 
verdadera. Para tu programa, necesitaremos usar el botón A0, el valor es 0 
para ~. Deberá usar los siguientes dos bloques para programar tu 
condición:

・・ ¡Este bloque verifica el valor de un botón!

・・・This block compares the values on the left and

right to see if they're equal!

Left value is equal to right

〇
Left and right values are unequal

×

Drag Drop the block when
you see the white 
line!

Your <ボタンA0=0_b>     block is 

now the condi t ion for  when

button A0's value is 0. That means

this action won't run if A0's value

is 1!

Click! Click!

<<<<<<<<<<<<<<<<<<<<<ボボタボタボタボタボタンンAンAンAンAンAンンAン 0=00==0==00==00==0_000 bbb>>>b>bbb>bb>bbbbb

1) Click                   . Now drag and

place an               block.

2) Click                    . Now drag a

                     block into the left 〇 of 

the             block.

5 Abriendo tu puerta con solo presionar 
un botón

１１ ００

０

 4   
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Presionado si el valor es 0



●①

Do you think there's a way for your Studuino to tell whether you're pressing

A0? Take a look at the Sensor Board at the top right of your screen and try

pressing the button!

A0 is released

Notice how the number changes when you press A0? Your Studuino watches 

this number and uses it to tell when you're pressing the button. Programmers

call these kinds of numbers values.

Now we're going make a program that gives your Studuino the following
instructions:

Released if value is 1 Pressed if value is 0

A0 is pressed

If button A0 value is 0

turn Servomotor to open door (this is what you programmed in      !)

Just like it says, if ~ ○○ will only run the action in ○○ if the condition in 

~ is true. For your program, we'll need to use button A0 value is 0 for ~. 

You'll need to use the following two blocks to program your condition:

・・・This block checks the value of a button!

・・¡Este bloque compara los valores de la izquierda y la
derecha para ver si son iguales!

El valor de la izquierda es igual 
al de la derecha

〇
Los valores izquierdo y derecho 
son desiguales

×

Drag ¡Suelta el bloque 
cuando veas la 
línea blanca!

Click! Click!

Ahora tu bloque 
es la condición para que el valor del 
botón A0 sea 0. ¡Eso significa que 
esta acción no se ejecutará si el 
valor de A0 es 1!

2) Has click en

Ahora escribe 0 en la derecha O del 
bloque

5 Opening Your Door With the Push of 
a Button

１１ ００

4
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1) Has click en

. Ahora arrastra y coloca un bloque ahora arrastra un bloque

a la izquierda O del bloque 

０



Ahora usaremos la condición de      para hacer una sección si ~ 
○○ para tu programa. Usa los siguientes bloques para programar
una condición si:

●② Now click the                   to send the program to your Studuino and

press A0. Did the door open?

●③

Now hold down the button and click                     . Did the door open?●④

●①

3) Arrastra tu bloque de 2) a la parte
inferior del bloque
y úsalo para encerrar el resto de tu
programa.

This program will only tell your 

Studuino to check if you've 

pressed A0 once, right after the

program starts. It won't react at 

all if you press the button again!

Your Studuino runs programs 
incredibly fast, and the blocks it runs 
will be shown with a white outline. 
The reason you don't see the outline
in the picture to the left is because
the program started and stopped
almost instantly!

・ ・ ¡Coloca bloques dentro de este, para
ejecutarlos cuando la condición dentro
de         se cumpla!

 .

クリック! It did!

・

It didn' t . . .

It did!

・

It didn' t . . .

Hold down the button

Click!

¡Suelta el bloque 
cuando veas la línea 
blanca!

あか
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1) Has click en
. Ahora arrastra y coloca un bloque

2) Arrastra tu bloque
en el

Arrastra

¡Suelta el bloque 
cuando veas el 
contorno blanco!



Now we'll use the condition from ① to make an if ~ ○○ section for

your program. Use the following blocks to program an if instruction:
●② ●③

Ahora mantén presionado el botón y has click en

●①

1) C l i ck              .  Now drag

and place an            block.

2)  Drop your  <ボタンA0=0_b> 

block into the       .

3) Drag your block f rom 2)  to 

the bot tom of  the                                              

block and use it to enclose the 

rest of your program.

Este programa solo le indicará a tu 
Studuino que verifique si 
presionaste A0 una vez, justo 
después de que se inicia el 
programa. ¡No reaccionará si 
presionas el botón otra vez!

Tu Studuino ejecuta programas 
increíblemente rápido, y los bloques 
que ejecuta se mostrarán con un 
contorno blanco. ¡La razón por la que 
no ves el contorno en la imagen de la 
izquierda es porque el programa 
comenzó y se detuvo casi al instante!

・・・Place blocks inside of this one to run

 them when the condition inside of the

             is met!

<<<<<<<<<<<<<<<<<<<<<<<<ボタボタボタボタボタンAンンンンAンAAンAAAンンンンAンンA000====000 00_00000__b>b>b>b>b>>>>>>>b>b>>>>

Drag

para enviar el programa a tu Studuino y 

¡Lo hizo!

 ・

¡No lo hizo!...

Mantén presionado el botón

Click!

Drop the block when
you see the white
outline!

Drop the block when
you see the white
line!
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Ahora has click en

presiona A0. ¿Se abrió la puerta?

¿Se abrió la puerta?

¡Lo hizo!

 ・

¡No lo hizo!...

Click!



Click!

Click!

●⑥

Deberás agregar el siguiente bloque a tu programa, para que se ejecute 
más de una vez:

●⑤

・ ・¡Cualquier programa envuelto en este bloque, se
repetirá una y otra vez!

Has click en

¡Verás el contorno 
blanco esta vez!

¡La línea desaparecerá!

Has click en el bloque 

una vez más para 
detener tu programa.

And now you've finally finished the program for your Touch Sensor!

Wouldn't it be cool if your school had automatic doors? Talk with your class-

mates about where you think they should go!

B r a i n s t o r m

〇 Save Your Program

You'll be using this program in the next chapter. Listen closely to your 

teacher as they tell you how to save it!

〇 Cleanup

You'll need your automatic door for the next chapter, so store it in a box to 

keep it safe for your next class. And don't forget to turn off your Battery

Box!
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. Ahora arrastra un bloque al fondo del
bloque

Arrastra

Ahora has click en el bloque y presiona A0.
¿Se abrió la puerta?



Click!

Click!

●⑥

You'll need to add the following block to your program to make it run more

than once:

●⑤

・・・Any programs wrapped in this block will

repeat over and over again!

Click               .  Now drag a             block to the botto

          block.

Now click the               block and press A0. Did the door 

open?

You'll see the white
outline this time!

The line will disappear!

Drag

Click the            

block one more 

time to stop your 

program.

¡Y ahora finalmente has terminado el programa para tu sensor táctil!

¿No sería genial si tu escuela tuviera puertas automáticas? ¡Habla con tus 
compañeros de clase sobre dónde crees que deberían ir!

I d e a  g e n i a l

〇 Guarda tu programa

Usarás este programa en el próximo capítulo. ¡Escucha atentamente a tu 
profesor mientras te dice cómo guardarlo!

〇 Limpieza

Necesitarás tu puerta automática para el próximo capítulo, así que guárdala 
en una caja para mantenerla segura para tu próxima clase. ¡Y no te olvides 
de apagar tu caja de baterías!
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¡Puede que no estés muy feliz de ver una puerta táctil si tienes dos brazados de 
comestibles! Es por eso que usaremos un sensor llamado fotorreflector IR para 
programar una puerta reflectora que se abre automáticamente cuando te acercas a 
ella.

〇 ¿Que es un fotorreflector IR?

Este sensor obtuvo su nombre porque 
refleja un tipo de luz llamada luz infrarroja. 
¿Te das cuenta de los pequeños círculos 
negros y claros en el frente? El círculo claro 
envía luz infrarroja, y el círculo negro 
detecta la cantidad de luz reflejada. ¡La 
fuerza de esta luz es cómo puede decir si 
un objeto está delante de ella!

Puertas táctiles Puertas reflectoras

Detecta luz 
infrarroja

Emite luz 
infrarroja

Emisor

Detector
Luz reflejada

Detecta

Senso
r

O
bjeto

There are lots of different types of light, and they're used all around you!

〇 Light in the World Around You

Hospital x-rays use these!
X-rays can be used to take pictures
of the human body because our
bodies absorb them!

Need to disinfect something? 
Go with ultraviolet!

They can also give you a 
great tan!

This is what you see!

This one contains all the
colors of the rainbow!

Just like in your remote control!

You can send signals by turning
an infrared light on and off!

The power behind the
microwave oven!
Microwaves heat up water to 

make your food steaming hot!

Where would TV and radio be 
without these?
You can send radio waves a lot
farther than other types of light!

X-rays

Ultra
violet
Rays

Visible
Light

Infrared
Light

Micro
waves

Radio
Waves

T
his light co

m
es to

 Earth fro
m
 the sun!

V
isib
le

Invisib
le

Invisib
le
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Capítulo 3 
Programando puertas con sensores



Chapter 3Chapter 3
Programming Doors

with Sensors

You might not be very happy to see a Touch Door if you have two armfuls of 

groceries! That's why we'll be using a sensor called an IR Photoreflector to 

program a Reflector Door that opens automatically when you get close to it!

〇 What's an IR Photoreflector?

This sensor got its name because it  

reflects a type of light called infrared light. 

Notice the little black and clear circles on 

the front? The clear circle sends out

infrared light, and the black circle detects

the amount of light that's reflected back.

The strength of this light is how it can tell 

whether an object is in front of it!

Touch Doors Reflector Doors

Emits 
infrared light

Detects 
infrared light

Emitter

Detector
Reflected light

Detects

Senso
r

O
bject

¡Hay muchos tipos diferentes de luz y se usan a tu alrededor!

〇 Luz en el mundo que te rodea

¡Las radiografías del hospital 
usan esto!

¡Los rayos X se pueden usar para tomar 
imágenes del cuerpo humano 
porque nuestros cuerpos las absorben!

¿Necesitas desinfectar algo? Ve 
con ultravioleta!

¡También pueden darte un buen 
bronceado!

¡Esto es lo que ves!

¡Este contiene todos los colores 
del arcoíris!

¡Al igual que en tu control remoto!

Puede enviar señales encendiendo 
una luz infrarroja y apagándola.

¡La potencia detrás del horno 
de microondas!
¡Las microondas calientan el 
agua para hacer que tu comida 
esté caliente!

¿Dónde estaría la televisión y 
la radio sin estos?
¡Puedes enviar ondas de radio 
mucho más lejos que otros tipos de 
luz!

Rayos x

Rayos 
Ultra 
violeta

Luz 
Visible

Luz 
Infrarroja

Micro 
ondas

ondas
de
Radio

La luz viene a la tierra, del sol

V
isib
le

Invisib
l e

Invisib
le
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Conecta un cable de conexión del sensor en tu fotorreflector IR y agrega los 
bloques que se muestran.

Necesitarás

Cable de conexión del sensor 
(S) x 1

(3-cables, 15 cm)Fotorreflector IR x 1Mitad C (Light Aqua) x 1

● Tu puerta del capítulo 2

Cubo básico (Blanco) x 4

Agregando un fotorreflector IR a tu 
puerta

1

●①

●②

●③

Agrega la parte      a la puerta automática del Capítulo 2.

Conecta tu cable del 
fotorreflector IR  en A1 en 
tu Studuino.

Now you're finished!

A１

Open the folder where you saved your program.

Click the File menu at the top of the screen and choose Open.

Open Your Program From Chapter 22

●②

●①

You'll need to make a new program by editing your program from Chapter 2. 

You can open any program you've saved by following these steps:

Click!

Click!

Click!

Click!

Now choose your program and click the OK button!●③

Click!

You'll see your program
from Chapter 2!

★ Ask your teacher for help if you can't remember
where you saved it!
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Plug a sensor connecting cable into your IR Photoreflector and add the
blocks shown.

You'll Need

Sensor Connecting Cable (S) x 1
(3-wire, 15 cm)IR Photoreflector x 1Half C (Light Aqua) x 1

● Your door from Chapter 2 

Basic Cube (White) x 4

Adding an IR Photoreflector to
Your Door

1

●①

●②

●③

Add part ① to your automatic door from Chapter 2.●①

Plug your IR Photoreflector's
cable into A1 on your Studuino.

¡Ahora has terminado!

A１

Abra la carpeta donde guardaste tu programa.

Has click en el menú Archivo en la parte superior de la pantalla y elige Abrir.

2

●②

●①

Abre tu programa del Capítulo 2
Necesitarás crear un nuevo programa editando tu programa desde el Capítulo 2. 
Puede abrir cualquier programa que hayas guardado siguiendo estos pasos:

Click!

Click!

Click!

Click!

¡Ahora elige tu programa y has click en el botón Aceptar!

Click!

Verás tu programa del 
Capítulo 2.

★ Pídele ayuda a tu maestro si no puedes recordar dónde lo
guardaste.
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Configura tus puertos3
¡Ahora tendrá que decirle a tu Studuino que conectaste un fotorreflector IR a A1!

Has click en Aceptar para cerrar la ventana de Configuración del puerto.

Marca A1 debajo de Sensor / LED / Timbre.

Elige fotorreflector IR de la lista.

Plug in Your Studuino
(Test Mode)

4

Click the Run menu at the top of your screen and choose Test ON.●②
Click!

Click!

We'll need to use a USB cable to let your computer send instructions to 

your Studuino!

Connect your Studuino to your PC using a USB cable.●①
To StuduinoTo PC

Make sure it's inserted
correctly!

USB
Cable
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Has click en el menú editar en la parte superior de tu 
pantalla y elige configuración de puerto.

Click!



Set Your Ports3

●①
Now you'll need to tell your Studuino that you connected an IR Photoreflector to A1!

Click!

Click!

Click the Edit menu at the top of your screen and choose Port Settings.

●④ Click OK to close the Port Settings window!

●②Check A1 under Sensor / LED / Buzzer.

●③ Choose IR Photoreflector from the list.

4

¡Tendremos que usar un cable USB para que tu computadora envíe 
instrucciones a tu Studuino!

Click!
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Conecta tu Studuino (modo de prueba)

Al Studuino A la PC

¡Asegúrate de que está 
insertado correctamente!

Has click en el menú Ejecutar en la parte superior de la 
pantalla y selecciona prueba activada.

 Conecta tu Studuino a tu PC con un cable USB.



Emisor

DetectorS
ensor Bloques 

blancos

Un alto valor significa que tu 
fotorreflector IR está detectando una 
gran cantidad de luz infrarroja. ¡Esto 
se debe a que la luz emitida por el 
sensor se refleja mucho más 
intensamente cuando tus bloques 
blancos están cerca!

Put your finger in front of the sensor.

The value will get bigger because 

your finger reflects infrared light, too! 

●④ Now we'll use your threshold from ③ to make a condition by combining 
the blocks shown below:

・・・This block checks the value of the
IR Photoreflector!

・・・. This one checks whether the number on the left is bigger
than the one of the right!

Left value is greater than the right

〇
Left value is less than the right

×

●①

●② ●③ In ②, you saw that your IR Photoreflector's value got bigger when you
placed a person in front of it. This is what you'll use to make a condition
that instructs your Studuino to open the door when your IR Reflector's 
value is big! But how big should that value be?

●②

Comprobación de los valores de tu 
reflector de infrarrojos5

¡Haz una persona al armar 
cuatro bloques blancos!

Mira la placa del sensor en la parte superior derecha de tu pantalla y 
coloca a la persona que hiciste en     frente a tu fotorreflector IR. Ahora
sácalo y ve cómo cambian los valores

Cuando nadie está allí ... Pero cuando están ...

El valor de mi fotorreflector IR es

●①

IR Photoreflector value is big

Someone's standing there...

What's the value?
1000

A person is standing there if my IR Photoreflector's value is bigger than

The number that you pick out of a range of values in order to decide 
something is called a threshold. Use your results from ② to pick a threshold
and write it in the box below!

●②

●③
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El valor de mi fotorreflector IR es



Emitter

DetectorSenso
r White

blocks

A high value means that your IR 

Photoreflector is detecting a lot of 

infrared light. This is because the

light emitted from your sensor is 

reflected back a lot more strongly 

when your white blocks are nearby!

Pon tu dedo delante del sensor. ¡El 
valor aumentará porque tu dedo 
también refleja la luz infrarroja!

El valor de la izquierda es mayor que el 
derecho

〇
El valor de la izquierda es menor que el 
derecho

×

●①

●② ●②

Checking Your IR Photoreflector Values5
Make a person by putting

together four white blocks!

Look at the Sensor Board at the top right of your screen and place the

person you made in ① in front of your IR Photoreflector. Now take it 

away and see how the values change!

When no one's there... But when they are...

My IR Photoreflector's value is My IR Photoreflector's value is

●①

El valor del fotorreflector IR es grande

Alguien está ahí parado ...

¿Cuál es el valor?
1000

Una persona está parada allí, si el valor de mi fotoreflector IR es más 
grande que

El número que eliges de un rango de valores para decidir algo, es llamado 
umbral. ¡Usa tus resultados de   para elegir un umbral y escríbelo en
el recuadro de abajo!

Ahora usaremos tu umbral de  para hacer una condición combinando 
los bloques que se muestran a continuación:
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En   , viste que el valor de tu fotorreflector IR se hizo más grande
cuando colocaste a una persona delante de él. ¡Esto es lo que usarás 
para crear una condición que le indique a tu Studuino que abra la puerta 
cuando el valor de tu fotorreflector IR sea grande! Pero, ¿qué tan 
grande debería ser ese valor?

●②

... ¡Este bloque verifica el valor del 
fotorreflector IR!

... ¡Este verifica si el número de la izquierda es más grande 
que el de la derecha!



1) Has click en 2) Has click en

③ 

●⑤

●⑥

Replace your program from Chapter 2 with your condition from ④.●④

Drag and drop blocks to the
left side of your screen to delete them!

Turn your Battery Box on to give your Servomotor some power!

Drag

Drag

¡Este es el umbral de       !●③

3) Escribe el umbral que elegiste en

la derecha ○ de

¡Suelta el bloque cuando 
veas el contorno blanco!

ON OFF
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. Ahora arrastra y coloca un bloque . Ahora arrastra un bloque
a la

izquierda O del bloque

Drag Arrastra



1) Click                    . Now drag

and place a                 block.

2) Click                    . Now drag

an                                     block 

into the left 〇 of the             

block.

3) Type the threshold you chose in ③ 

into the right ○ of     <>_b>.

●⑤

●⑥

Reemplaza tu programa del Capítulo 2, con tu condición de      .

¡Arrastra y suelta bloques en el lado izquierdo de 
la pantalla para eliminarlos!

¡Enciende tu caja de baterías para darle algo de potencia a tu Servomotor!

Drag Drag

This is the threshold from ●!●③

●③
<><<><<>>_bbb_b_ >>>>>>.>>>>>>>>>

Drop the block when you 
see the white outline!

ON OFF
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Programaste dos tipos de puertas diferentes en este capítulo y en el Capítulo 2. 
¿Podrían ser más convenientes? ¿Hay alguna forma de que puedas hacerlas 
más seguras?

H o r a  d e  p e n s a r

Anota tus pensamientos aquí!

Click!
Chapter 4Chapter 4

A Safer Automatic Door

The automatic doors you made in Chapters 2 and 3 could be a lot safer, don't you

think? Look below to see some ways they could be improved! 

In order to fix the problems in ① and ② and make an even safer door, we'll have to

modify your program from Chapter 2!

Someone could get hurt if the door closes too fast!●①

●① ●②

A door might bump into someone if it opens backwards!●②

Maybe people
could get out of 
the way if the
door closed 
more slowly?

Think you could
use a sensor to 
tell if someone is 
standing behind
the door?

〇 Guarda tu programa

¡No uses el mismo nombre que utilizaste para tu programa en el Capítulo 2!

〇 Limpieza

Necesitarás tu puerta automática para el próximo capítulo, así que guárdala 
en una caja para mantenerla segura para tu próxima clase. ¡Y no te olvides 
de apagar tu caja de baterías!

Ahora has click en el bloque
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para enviar el programa a tu

Studuino y ver cómo funciona.



You programmed two different types of doors in this chapter and in Chapter 2. 

Could they be more convenient? Is there a way you could make them safer?

T  h  i  n  k  i  n  g    T  i  m  e !

Jot down your thoughts here!

Click!

Para solucionar los problemas en   y   y hacer una puerta aún más segura, 
¡tendremos que modificar tu programa del Capítulo 2!

Las puertas automáticas que creó en los Capítulos 2 y 3 podrían ser mucho más 
seguras, ¿no cree? ¡Mire abajo para ver algunas maneras en que podrían mejorarse!

        ¡Alguien podría lastimarse si la puerta se cierra demasiado rápido!

●①   ●②

¡Una puerta puede golpear a alguien si se abre hacia atrás!

¿Tal vez la gente 
podría salir del 
camino si la 
puerta se cerrara 
más lentamente?

¿Crees que 
podrías usar un 
sensor para decir 
si alguien está 
detrás de la 
puerta?

〇 Save Your Program

Don't use the same name that you used for your program from Chapter 2!

〇 Cleanup

You'll need your automatic door for the next chapter, so store it in a box 

to keep it safe for your next class. And don't forget to turn off your Battery

Box!

●⑦ Now click the block to send the program to your Studuino

and see how it works!
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Capítulo 4 
Una puerta automática más segura



USB
Cable

Programando una puerta más segura

Necesitarás

● Tu puerta del Capítulo 3.

Cable USB x 1

1 Abre tu programa de la puerta táctil

Abre la carpeta donde guardaste tu programa.

Has click en el menú Archivo en la parte superior de la pantalla y elija Abrir.

●②

●①
Click!

Click!

Click!

Click!

¡Ahora elige tu programa y has click en el botón Aceptar!

Click!

★ Pídele ayuda a tu maestro si no
puedes recordar dónde lo
guardaste.

¡Verás tu programa del Capítulo 2!

Connect your Studuino to your PC using a USB cable.●①

●② Click the Run menu at the top of your screen and choose Test ON.

Click!

Click!

To StuduinoTo PC

Make sure it's inserted
correctly!

Plug in Your Studuino (Test Mode)２

Set Your Ports3
You'll need to use your IR Photoreflector in this chapter and, just like in Chap-

ter 3, you'll need to tell your Studuino that you've connected it!

Click!

Click!

●① Click the Edit menu at the top of your screen and choose Port Settings.
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Cable USB

Programming a Safer Door

You'll Need

● Your door from Chapter 3

USB Cable x 1

1 Open Your Touch Door Program

Open the folder where you saved your program.

Click the File menu at the top of the screen and choose Open.

●②

●①
Click!

Click!

Click!

Click!

Now choose your program and click the OK button!●③

Click!

★ Ask your teacher for help if you
can't remember where you saved 
it!

You'll see your program from Chapter 2!

Conecta tu Studuino a tu PC usando un cable USB.

Al Studuino A la PC

¡Asegúrate de que está 
insertado correctamente!

２

Configura tus puertos3
Necesitarás usar tu fotorreflector IR en este capítulo y, al igual que en el Capítulo 
3, ¡tendrás que decirle a tu Studuino que lo has conectado!
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Has click en el menú Ejecutar en la parte superior de la 
pantalla y selecciona prueba activada.

Has click en el menú editar en la parte superior de 
tu pantalla y elige configuración de puerto.

Click!

Conecta tu Studuino (modo de prueba)



1) Click                    . Now drag

and place a                            

block at the bottom of your program.

Has click en Aceptar para 
cerrar la ventana de 
Configuración del puerto.

Marca A1 debajo de 
Sensor / LED / timbre.

Elige fotorreflector IR de 
la lista.

Click!

4 Haciendo una puerta más lenta
¡Una puerta que se cierra más lentamente, le dará tiempo a cualquiera que esté cerca 
para escapar! Pero para hacer que tu puerta haga esto, necesitarás cambiar la 
velocidad de tu Servomotor.

        ¡Enciende tu caja de baterías para darle algo de potencia a tu Servomotor!

Puedes cambiar la velocidad de tu Servomotor utilizando el siguiente 
bloque:

2) Drag the Servomotor block under

the               block to the inside 

of                                 !

3) Now drag and place 2) under

the            block!

ON OFF

Drop the block when 

you see the white line!

Click!

Drag

Drop the block when 

you see the white line!
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... Utiliza este bloque para 
cambiar la velocidad de tu Servomotor 
o hacer que varios Servomotores se
muevan a la vez.



・・・Use this block to change the speed

of your Servomotor or make multiple 

Servomotors move at once!

●④ Click OK to close the

Port Settings window!

●②Check A1 under

Sensor / LED / Buzzer.

●③ Choose IR Photoreflector

from the list.

Click!

Making a Slower Door4
A door that closes more slowly will give anybody nearby plenty of time 

to get away! But to get your door to do this, you'll need to change the

speed of your Servomotor.

Turn your Battery Box on to give your Servomotor some power!●①

●② You can change the speed of your Servomotor by using the following block:

ON OFF

2) Arrastra el bloque del servomotor
debajo del bloque dentro de

3) Ahora arrastre y coloque 2) debajo
del bloque

¡Suelta el bloque cuando 

veas la línea blanca!
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1) Has click en

ahora arrastra y coloca un bloque

en el fondo de tu programa.

Click!

Arrastra

¡Suelta el bloque cuando 
veas la línea blanca!



Making a Door Open Only When
No One's Behind It

5●③

●④

Has click en ▼ en el bloque

y establece su velocidad a 0.

Rápido

¡Puede configurar la velocidad de un Servomotor en cualquier lugar entre 0 y 
200!

Valores

０ 20

El más 
pequeño

El más 
grande

Velocidad del servomotor

Lento

Ahora has click en el bloque

You can make your door check whether someone is standing behind it by 

using an IR Photoreflector. We'll need to move it to the back of your door and

make the door open only when you press the button and no one is there!

Move your IR Photoreflector to the place shown.●①
BackFront

●② Just like you did in Chapter 3, check your sensor's values for when

a person is standing there and when no one's standing there!

When no one's there... But when they are...

My IR Photoreflector's value is My IR Photoreflector's value is
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para enviar el programa a tu

Studuino y ver si tu puerta se cierra más lentamente!

Click!



Hacer que se abra una puerta, solo 
cuándo nadie esté detrás.

5●③

●④

Click the ▼ in the                                    block and set its speed to 0.

Click!

Click!

Fast

You can set a Servomotor's speed anywhere from 0 to 200!

Values

０ 20

Smallest Largest

Servomotor Speed

Slow

Now click the                       block to send the program to your 

Studuino and see if your door closes more slowly!

Puedes hacer que tu puerta verifique si alguien está detrás de ella utilizando un 
fotorreflector IR. Tendremos que moverlo a la parte posterior de la puerta y abrir 
la puerta solo cuando presionas el botón y ¡no hay nadie allí!

         Mueve tu fotorreflector IR al lugar que se muestra.

AtrásFrente

Cuando nadie está allí ... Pero cuando están ...
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¡Tal como lo hiciste en el Capítulo 3, verifica los valores de tu sensor para 
cuando una persona está de pie allí y cuando no hay nadie allí!

El valor de mi fotorreflector IR esEl valor de mi fotorreflector IR es



Combine your                block with your condition from ④ to make 

your door open only when no one is there.
●⑤

¡Esta vez necesitarás tomar los resultados de    para decirle a tu 
puerta que no hay nadie allí!

●③

●④

●④

●②

El valor del fotorreflector IR es pequeño

¡Nadie está allí!

¿Cuál es el 
valor?

Nadie está parado al l í  si el valor de mi fotoreflector IR es más 
pequeño que

Usa el siguiente bloque para hacer una condición para cuando no haya nadie allí:

El valor de la izquierda es menor que 
el derecho

〇
El valor de la izquierda es mayor que 
el derecho

×

Éste veri f ica si el número de la izquierda es más 
pequeño que el de la derecha

1) Has click en

2)  Click                . Now drag an

                                block into the

left 〇 of the             block.

3)  Type the threshold you

chose in ③  into the right ○ 

of              .

1) Click                   . Now drag an               block to the place shown.

●③

This is the threshold
from ● !●③

Drag

Drag

・・・

1000

Drop the block when you

see the white outline!

Click!
Drop the block when you

see the white outline!
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. Ahora arrastra y coloca un bloque



●⑤

This time you'll need to take your results from ② to tell your door that no 

one's standing there!
●③

●④

●④

●②

IR Photoreflector value is small

No one's there!

What 's the
value?

No one is standing there i f  my IR Photoreflector's value is

smaller than □

Use the following block to make a condition for when no one is there:

Left value is less than the right

〇
Left value is greater than the right

×

This one checks whether the number on the
lef t is smaller than the one on the right

1) Click               .  Now drag and place a            block.

2) Has click en

1) Has click en

Drag

3) Escribe el umbral que
elegiste en      a la derecha 

O de

¡Este es el umbral de       !

・・・

1000
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ahora arrastra un
bloque a la 
izquierda O del bloque

¡Suelta el bloque cuando 
veas el contorno blanco!

Combina tus bloques con tu condición de para abrir la puerta

solo cuando no hay nadie allí.

ahora arrastra un bloque al lugar
mostrado.

¡Suelta el bloque cuando 

veas el contorno blanco!



          .2) Suelta tu condición de        en el

¡Ahora has click en el bloque

Turn off your Battery Box.●①

●② Click the Run menu at the top of the screen and choose Transfer

to send a program to your Studuino.

●③Wait until the message you see here disappears.

●⑤ Turn your Battery Box on and your program will run. Press A0 and your

program will work just like it did in Test Mode!

ON OFF

Leaving Your PC Behind6
When you use Test Mode, your Studuino has to be connected to your PC with

a USB cable in order to run a program. That means you can't carry your 

Studuino around! But don't worry, there's another way to send programs to

your Studuino and run them without a computer!

●④ Once the message is gone, go ahead

and unplug your USB cable!

Click!

Click!

ON OFF
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¡Suelta el bloque 
cuando veas el 
contorno blanco!

¡Haz clic en el símbolo < 
cuando quieras arrastrar 
el bloque!

para enviar el programa a tu
Studuino y presiona A0 para asegurarte de que tu puerta permanezca 
cerrada cuando haya una persona debajo del sensor!

Click!



2) Drop your condition from  ④  into the          .●④

Drop the block
when you see the
white outline!

Click the < symbol
when you want to
drag the block!

●⑥ Now click the                       block to send the program to your Studuino

and press A0 to make sure that your door stays closed when there's a 

person under the sensor!

b

Click!

Enciende tu caja de baterías y tu programa se ejecutará. ¡Presiona A0 y tu 
programa funcionará como lo hizo en el modo de prueba!

ON OFF

6
Cuando utilizas el Modo de prueba, tu Studuino debe estar conectado a tu PC con un 

cable USB para ejecutar un programa. ¡Eso significa que no puedes trasladar tu 

Studuino! Pero no te preocupes, ¡hay otra forma de enviar programas a tu Studuino y 

ejecutarlos sin una computadora!

①    Apaga tu caja de baterías.

Drag

ON OFF
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Dejando tu PC atrás

Has click en el menú Ejecutar en la parte superior de la pantalla y elige 
Transferir para enviar un programa a tu Studuino.

Espera hasta que desaparezca el mensaje que ves aquí.

Una vez que el mensaje se haya ido, 
¡desconecta tu cable USB!



¡Intenta pensar cómo puedes resolver los problemas que pensabas al final del 
Capítulo 3, así como cualquier otro que puedas imaginar, y compártelos con tu 
clase!

〇 Guarda tu programa

¡No uses el mismo nombre que usaste para sus programas del Capítulo 2 y 3!

〇 Limpieza

¡No olvides apagar tu caja de baterías cuando estés limpiando!
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mostrar  y  contar

Problema Cómo resolverlo



Try thinking of how you can solve the issues you thought of at the end of 

Chapter 3, as well as any other ones you can come up with, and share them 

with your class!

Issue How to Solve It

〇 Save Your Program

Don't use the same name that you used for your programs from

Chapter 2 and 3!

〇 Cleanup

Don't forget to turn your Battery Box off when you're cleaning up!

S h o w  a n d  T e l l
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